Endnote Web: Beginners Guide to Using Endnote Web and the Cite While You Write Function

1  Endnote Web User Guide Version 3.4
Created: June 2012
Author: Jessica Eustace-Cook
Table of Contents

1. About Endnote
   1.1 Setting up your EndNote Web Account
   1.2 Logging In to EndNote Web

2. Getting Started in Endnote Web

3. Organizing your References
   3.1 Managing your References:
   3.2 Creating a Group:
   3.3 Sharing Groups:
      3.3.1 Sharing Groups
   3.4 Unsharing Groups
   3.5 Hiding Groups Shared from Others
      3.5.1 Important Points about sharing groups:

4. Manual Entry of References:
   4.1 Entering Author Names

5. Direct Import of References:

6. Managing your References:
   6.1 Deleting References:
   6.2 Editing References
   6.3 Importing References:
   6.4 Deduplicating Records:

7. Creating a Bibliography
   7.1 To create a bibliography:
   7.2 To create a quick list:

8. Cite While You Write
   8.1 Inserting a Citation Within Word:
   8.2 Editing Citations Within Word:
   8.3 Formatting your Bibliography in Word:
   8.4 Removing Field Codes for Publishing:
Endnote Web

1. About Endnote
EndNote Web is a Web-based version of EndNote which is designed to help students and researchers through the process of writing a research paper.

System Requirements:

Browser Requirements

Microsoft® Internet Explorer 6.0-7.0*
FirefoxTM 1.5 - 2.0*
SafariTM 1.3 - 2.0*

Windows Plug-in Requirements

Microsoft® Windows® XP SP2 or later / Vista
Microsoft® Internet Explorer® 6.0-7.0* with the latest service pack set as the default Web browser
FirefoxTM Browser 1.5-2.0* for Windows set as the default Web browser

Macintosh Plug-in Requirements

Macintosh® OS X 10.3.9 and 10.4.x
Microsoft® Word® X/2004
FirefoxTM Browser 1.0-2.0* for Macintosh set as the default Web browser

• Cookies and JavaScript must be enabled in the Web browser settings.

The product is best viewed in 800 x 600 resolution.

1.1 Setting up your EndNote Web Account

1. To access EndNote web, TCD members should go to www.myendnoteweb.com (using a PC on campus).

2. Once on the Endnote Homepage, click on the blue hyperlinked “Sign Up” to create an account.

3. Creating an account with EndNote Web is a quick process. Simply:
   a) Type your first name in the First Name field.
   b) Type your last name in the Last Name field.
   c) Type your middle initial in the Middle Initial field (optional).
d) Type your password in the Password field. And also in the Retype Password field.

**Password Guidelines:**
- Must be 8 or more characters (no spaces) and contain:
  - at least 1 numeral: 0 - 9
  - at least 1 alpha character, case-sensitive
  - at least 1 symbol: ! @ # $ % ^ * ( ) ~ `{ } [ ] |

Example: 1sun%moon

e) Type your e-mail address in the E-mail Address field and in the Retype E-mail Address field.

f) Select your primary role in the Primary Role/Title field.

g) Select your subject area in the Subject Area field.

h) Select the bibliographic software you are using in the Bibliographic Software Use field (optional).

i) Select the appropriate radio button to Opt in or Opt out for e-mail communication.

4. Finally click the “I Agree” button indicating that you agree to the Terms and Conditions.

Users should note that if you are already registered in the Web of Knowledge, you do not have to register for EndNote Web. Go to www.myendnoteweb.com to login using the same login credentials.

**1.2. Logging In to EndNote Web**

1. Return to the EndNote Web home page and enter in your username and password:
1. Click Log-In to proceed.

2. Getting Started in Endnote Web

1. This is the “My References” tab in Endnote Web. You will only see this page the first time you login to Endnote.

2. Once you have created or imported some references you will see the My References tab with a list of your references in your library.

3. To use Endnote Web with Word then you will need to download and install the EndNote Web Cite While You Write plug-in and/ or Firefox Extension.
4. To download the EndNote Web Cite While you write plug in scroll to the bottom of the “My reference Tab.
5. Click on the “Download Installers” hyperlink.

6. Select the Installer most appropriate to you. In most cases this will be the “Download Windows” option.

7. A new window will open with an installation walk through screen.

You can fill in these details or leave blank as appropriate Click “Next” to continue.
Confirm the destination of Endnote Web – click next

Follow the instructions and you will be guided through until you see this page. Simply Click on “Finish”
3. Organizing your References

3.1 Managing your References:

1. Click on the organize tab in the Endnote window.

2. All references imported into Endnote Web are stored in your “Unfiled” stores until they have been copied to a group in your library.

Important Points about Unfiled:

- You cannot delete or rename Unfiled.
- You cannot copy references to Unfiled except from reference groups shared to you or Online Search results.
- A reference is automatically moved to Unfiled when you delete the reference from all personal groups.
- References imported through the Import References tool are stored in Unfiled automatically.
- References collected using Capture are stored in Unfiled unless one or more groups are specified before saving.

The Organize tab gives you the option to create groups. Groups can be used to organize your references in a more coherent manner. We recommend that you create groups to organize your references into relevant subgroups for example chapter sections or a group for separate papers.

3.2 Creating a Group:

To create a group:

1. Click the organize tab which will display the Manage Groups page.
2. In the upper Manage Groups table, click the **New Group** button in the bottom row.
3. Enter a name up to 255 characters in the New Group dialog.
4. Click the **OK** button

**n.b. References can belong to more than one group.**

### 3.3 Sharing Groups:

You can share groups with colleagues easily in EndNote Web. Colleagues that have access to your shared groups will see them in their Groups Shared by Others section of the left navigation pane.

You can share your groups with anyone that has an EndNote Web account. Below are instructions to share groups, unshare groups, and hide groups shared to you.

#### 3.3.1 Sharing Groups

1. Click the **Organize** tab which will display the Manage Groups page.
2. Find the group you wish to share and click the **Share Group** button.
3. Enter up to 1,000 e-mail addresses in the Share Group dialog separating each address by pressing the Enter or Return key. You can also provide a text file containing e-mail addresses separated by commas using the **Browse** button.
4. Click the **Apply** button.

To modify the sharing settings for a group, just click the **Modify Sharing** button and update the settings as needed.

### 3.4 Unsharing Groups

1. Click the **Organize** tab which will display the Manage My Groups page.
2. Find the group you wish to unshare and click the **Modify Sharing** button.
3. Select all the e-mail addresses for Step 1 in the Share Group dialog and press **Delete**.
4. Click the **Apply** button.
3.5 Hiding Groups Shared from Others

1. Click the Organize tab, then click the Others’ Groups link.
2. Uncheck the group you wish to hide.
3. Click the Apply button.

3.5.1 Important Points about sharing groups:

- You can share groups with EndNote Web users at any institution.
- You can share groups with individuals who have not yet created their EndNote Web account. The group will automatically appear after they’ve registered and logged in.
- Access to shared groups is read-only.
- References in shared groups can be searched.
- References in shared groups cannot be copied to your Quick List.
- Shared groups are available to generate a Bibliography or an export file

4. Manual Entry of References:

You can add references to your EndNote Web library by typing the bibliographic information in the fields provided on the New Reference page.

1. To add a new reference:
2. Click on the “Collect” tab at the top of the screen.
3. Click on the “New Reference” hyperlink.
4. Change the Reference Type by selecting the appropriate type from the Reference Type drop-down list box. The screen will redraw when the reference type changes, displaying appropriate fields for that reference type.
4. Enter the bibliographic data in each of the fields in the reference. Reference fields most commonly required for a properly formatted citation and bibliography are in the Bibliographic fields section.

5. When you have entered all of the required bibliographic data, scroll down to the bottom of the page and select a group to enter your new reference into. For example chapter 1 (which we created earlier) You can create a new group at this stage by giving it a title in the box provided – this is illustrated below.

6. Click the Save button to save your new reference.

Tip:

4.1 Entering Author Names

Author names can vary greatly so refer to the examples below for accurate formatting.

Single Author

Smith, John Allen
Smith, J.A.
Smith, J A

Multiple Authors (Do not include "et al.")

Smith, John Allen; Doe, J.; Green, M. T.

Complex Author Names (Last, First, Title)

dé Gaulle, Charles
Smith, John, Jr.
Smith, James, Jr

Anonymous Author (leave blank)

Company or Institutional Authors (Include a comma at the end)

Oregon Department of Geology and Mineral Industries,
Complex Company or Institutional Authors (Include two commas in the name)
American Academy of Pediatrics,, Committee on Genetics

5. Direct Import of References:

You can perform searches of *ISI Web of Knowledge* products, PubMed®, and many other library catalog and reference database sites directly through EndNote Web.

1. Click the Collect tab.

2. In the connection file drop-down list, select the database. For example the Web of Science.

**Note:**

*To customize this list.*

The Online Search tool allows you to search a variety of online resources and save references easily to your library. By default, all available connection files appear in the Online Search Connection drop-down list. Defining your Connection Files Favorites allows you to show a smaller, more convenient list.

**Adding Connection Files to your Favorites**
- From the initial Online Search page, click the **Customize this list** link.
- Select one or more connection files from the All Connection Files list on the left.
- Click the **Copy to Favorites** button.

**Removing Connection Files from your Favorites**
- From the initial Online Search page, click the **Customize this list** link.
- Select one or more connection files from the Your Favorite Connection Files list on the right.
- Click the **Remove from Favorites** button.

3. Click the **Connect** button.
4. If the site requires access authentication, enter a User ID, Password, and Group ID on the authentication screen and click **Connect**.

**Note:** Connections to online databases through EndNote Web originate from the EndNote Web server rather than your connection, so IP authentication or proxy authentication will not take place, and a username and password may be required by the online database. Contact your institution’s help desk to see if they have a username and password for this resource.

5. Enter the search phrase in the **Search Criteria** field.

6. Select a field in the **Search Field** drop-down list to limit the search to a specific field.

7. Select a connector (And, Or, or Not) from the **Connector** drop-down list if searching for more than one expression.

8. Repeat steps 4-6 if appropriate.

9. Click the **Search** button.

10. Select the results range to retrieve.

11. As the results download, you can view the initial set. Click in the radio buttons to the left of the articles retrieved and from the drop down box select which group you wish for them to be added to. By not selecting a group these items will be added to an unfilled group.

**Note:** There are cases when the number of references downloaded does not match the original result count. This will occur if there are references without author and year information.
6. Managing your References:

6.1 Deleting References:

To delete a reference:

1. Click the check box to the left of a record.

2. Click the **Delete** button at the top of the page.

To delete a reference from a reference page:

1. Click the **Delete** button.
2. Click the OK button in the Confirmation window to delete the reference

6.2 Editing References

1. Find the reference you wish to edit under the references tab.

2. Click the Edit link for that reference in the far right column.
3. Edit all necessary fields.

4. Click the Save button at the top of the page to save changes.

Note: If you change the Reference Type, you may be required to input additional information for fields required for that type, or lose data input for the previous reference type which is not used for the new reference type.
6.3 Importing References:
The process to import references into your library requires only a few steps. First, it’s important that the import file is in the proper format. To determine the appropriate format, refer to the Import Formats in EndNote Web for details. EndNote Web provides hundreds of import filters for a variety of data sources, as well as the standard RIS and Tab Delimited Formats.

To import a file:

1. From the Collect tab, click the Import link.
![Import References](import REFERENCES)

2. For the File field, click the Browse button to find and select the file containing reference data.
3. For the Filter field, select the import filter that matches the reference data format.
4. Click the Import button.

The references imported from the selected file are now available in Unfiled.

6.4 Deduplicating Records:
You can check your library for duplicates at any time by clicking Organize tab, then clicking Find Duplicates in the secondary navigation.

Any reference identified as a duplicate will have a yellow background.

You can quickly check the ‘Duplicates’ checkbox to check all references with the yellow background to delete those references, move them or copy them to your Quick List.
7. Creating a Bibliography

EndNote® Web provides a bibliography feature allowing you to output your references in a specified bibliography output style and in a specified file format to e-mail, save or print.

7.1 To create a bibliography:

1. From the Format tab, click the Bibliography link.

2. Select the references to format, such as the quick list or a personal group, from the References drop-down list box.

7.2 To create a quick list:

1. Click the check box to the left of a record. Check the Check Page checkbox to check all references on a page or Check All to check all references in a group or list view.

2. Click the Copy To Quick List button.

3. Repeat steps 1-2 if you are selecting references from different pages and groups until your Quick List is complete. A warning message will display in your browser if you have exceeded your export data limit.

3. Select the output style from the Bibliographic style drop-down list box.
4. Click the **Save To**, **E-mail**, or **Preview & Print** buttons.

![Bibliography](image)

- A file using the **Save** option – a standard ‘File Download’ window will appear allowing you to open the file or save to disk. If saving to disk, a standard 'Save to' window will open so that you can browse to the folder location and name the file.
- An e-mail using the **Email** option – an 'e-mail' window will appear allowing you to enter the e-mail addresses of those to receive the e-mail, a subject, and a message.
- A printed list using the **Preview & Print** option – a ‘Preview & Print’ window will appear allowing you to print to a local or network printer.

8. Cite While You Write

### 8.1 Inserting a Citation Within Word:

While you are writing your paper, you can easily find and insert a citation using EndNote Web’s Find Citation(s) tool. This tool searches your entire library, meaning all reference fields for all references in your library.

To find and cite your source:

1. With your Word document open, place the cursor in the location where the citation should appear.
2. Click the **Find Citation(s)** button in the EndNote Web toolbar. Or from the **Tools** menu, select **EndNote Web** then **Find Citation(s)**. The Find Citation(s) dialog will appear.
3. Enter a search term in the **Search** field to find the reference or references to insert. Refer to Search Tips in this topic or search operators for ways to refine your search.
   
   **Note:** The search term must be a minimum of three characters.
4. Click the **Search** button.
5. Click the **Search** button.
6. Select the reference. To insert multiple references in one citation, click each reference while holding the Ctrl key.
7. Click the **Insert** button.

The citation appears at the cursor location, formatted according to the bibliographic style specified. The reference information is also automatically added to the bibliography.
Note: If you expect to see an in-text citation but only see the reference in the bibliography, check the bibliographic style selected in Format Bibliography. Not all styles format in-text citations, such as Chicago 15th A, Refman (RIS) Export, Tab-delimited, and Turabian Bibliography.

8.2 Editing Citations Within Word:

You can use EndNote Web’s Edit Citation(s) tool to add or exclude information in the citation, add or delete a citation, or change the order of citations in a group. To delete a citation, follow the steps below and use the Remove option in the Edit Citation(s) window.

To edit a citation:

1. In your Microsoft® Word document, highlight the citation to edit.
2. Click on the Edit Citation(s) button in the EndNote Web toolbar. Or from the Tools menu, select EndNote Web then Edit Citation(s). An Edit Citation(s) window will appear.
3. Select the appropriate edit option(s). The options available are:
   - Exclude the author – Removes the author’s name in the selected citation
   - Exclude the year - Removes the Year in the citation in the selected citation
   - Prefix – Adds the prefix entered in the Prefix field to the citation
   - Suffix – Adds the suffix entered in the Prefix field to the citation
   - Page(s) – Adds the page numbers in the citation
   - Insert – Launches a Find Citation(s) window to select an additional reference to add to the citation
   - Remove – Removes the reference highlighted in the citations field of the Edit Option(s) window from the citation

   Note: Use this option to delete citations. This will ensure that all field codes are also removed.

8.3 Formatting your Bibliography in Word:

Each time you find and insert a citation in your document, the bibliography automatically formats according to the style selected. You can change the bibliographic style or other layout options in the Format Bibliography window.

To format your bibliography:

1. Click the Format Bibliography button in the EndNote Web toolbar. Or from the Tools menu, select EndNote Web then Format Bibliography.
2. In the Format Bibliography dialog, select the style from the With output style drop-down list box.
3. If desired, modify the font and size for the references in the Bibliography.
4. Add a title in the Bibliography Title field, such as "Works Cited."
5. Click the OK button.

This will format your citations and bibliography according to the style and appearance specified.

**Bibliography**

8.4 Removing Field Codes for Publishing:

Some publishers require documents without field codes. EndNote Web provides a tool to create a formatted document stripped of Cite While You Write field codes.

To remove field codes in a formatted document:

1. Click the Remove Field Codes button in the EndNote Web toolbar. Or from the Tools menu, select EndNote Web then Remove Field Codes.
2. Next, you will be prompted to create a new document. Click OK to continue.
3. Save the new document making sure not to overwrite the original.

Tip:

Cite While You Write will not be able to edit the citations and bibliography in this new document. To make edits, you must edit the original document and use Remove Field Codes again.